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Rules

The rules of the game are simple:
· The game is played on a board containing a number of holes.
· Each hole can be empty or hold one marble.
· A legal move consists of one marble jumping over another.
· The jumped marble is removed from the board.

The object of the game (in the scope of this version of Super Marble Solitaire) is to eliminate 
all but one marble with the remaining marble being located in the goal.    If the game 
includes a marked marble, the last remaining marble must be the marked marble.



Goal
The goal is a hole that is uniquely marked on the board.



Marked Marble
A marble that is a different color than all the other marbles on the board.



Game menu commands

The Game menu offers the following commands:

New Game Starts a new game.
Design Game Design your own game.
Exit Exits Super Marble Solitaire.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Colors Changes colors.

Move menu commands

The Move menu offers the following commands: 

Take back Takes back your last move.



Help menu commands

The Help menu offers the following commands: 

Help Topics Displays the index of help topics.
Game Strategy View game strategy tips.
Using Help Help on how to use help.
About Super 
Marble 
Solitaire…

Displays copyright and version information.



Take back command (Move menu)

Use this command to take back the previous move.    You can take back (undo) your moves 
all the way back to the beginning of the game.

Shortcuts
Click with the left mouse button on any of the discarded marbles in the discarded marble

tray.

Toolbar:



New Game command (Game menu)

Use this command to start a new game in Super Marble Solitaire.    Select the type of new 
game you want to play in the Select Game dialog.

Shortcuts

Toolbar:
Keys: F2



Design Game command (Game Menu)

Use this command to remove or create your own games. The Design Game dialog will 
appear after selecting this command.

Shortcuts

Toolbar:



Colors command (View Menu)

Use this command to change the color of the marbles and/or board.

Shortcuts

Toolbar:



To remove a game, click on the game to be removed from the list and then click on the 
Remove button.

To create your own game, press the Create button.    The Game Designer window will appear.

Pressing the Cancel button will remove all the changes made to the list.

Pressing the OK button will accept all the changes.    The file sltrtemp.gtp (solitaire game 
template file) is created.    This file contains all the games in the updated list as shown in the 
dialog box.    This file is in binary format, therefore it cannot be edited with a text editor 
(such as notepad).    If you design some cool games that you want to share,    you can 
distribute this file to your friends.

If you want to start over with the original set of games, all you have to do is delete, or 
rename, the sltrtemp.gtp file.



Exit command (Game menu)

Use this command to end your Super Marble Solitaire session.    You can also use the Close 
command on the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Super Marble Solitaire, such as New Game.    A check mark 
appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Super Marble Solitaire,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Start a new game.

Design your own game.    Super Marble Solitaire will display the Design Game dialog 
after selecting this command.

 Take back move.

Select colors for marbles and board.

Display version and copyright information.

Context help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and displays the number 
of marbles left on the board. A check mark appears next to the menu item when the Status 
Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Super Marble Solitaire window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right area of the status bar indicates the number of marbles remaining on the board.



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Super Marble Solitaire and various types of 
reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Super 
Marble Solitaire.

Shortcuts

Toolbar:



Context Help command 

Use the Context Help command to obtain help on some portion of Super Marble Solitaire.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the Super Marble Solitaire window, such
as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1

Toolbar:



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Super Marble Solitaire window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Game Strategy Tips

The convention used for demonstration purposes is to letter the columns from left to right as
'a' through 'g'.    The rows are numbered from top to bottom as '1' through '7'.    Therefore the
center position in the diagram to the right is 'position d4'.

Strategy topics:
· The four marble classes
· Move patterns

Solutions using move patterns
· Classic game
· The Square



The four marble classes

The marbles can be divided into four classes according to their position on the board.    No 
matter where a marble is moved during play, it always remains in the same class as where it
started.

The middle marbles

The positions shown on the left are the only positions where the middle marbles can go (in 
the Classic game).    Note also that in the Classic game, you start out with only 4 middle 
marbles.    The objective of the Classic game is to end with only 1 marble (a middle marble) 
in the center position.    Therefore, if you have jumped over and removed all the middle 
marbles before the end of the game, it is impossible to win.    The middle marbles are then 
only ones that can move to the center position.

The corner marbles

The positions shown on the left are the corner positions.    Only corner marbles can move to 
these positions.    In the Classic game, you start out with 12 corner marbles.

The "S" edge marbles



The "S" marbles are important for clearing corner marbles from the side corners.

The "T" edge marbles

The "T" marbles are important for clearing corner marbles from the top and bottom corners.



Move patterns
Block Moves
· L-move
· 4-move
· anvil
· 4-3
· flat 10
· i-move
· pointed 10
· 7-plus-1
· tally

Block Removals
· 2-removal
· 3-removal
· L-removal
· 6-removal
· 9-removal
· double-2
· double-3
· double-Y
· 11-removal
· shifted 6
· straight 6
· 2-5
· Y-removal
· chain-removal



A block move is a defined series of moves that effectively replace a given set of marbles with a single marble in a 
specified position.    All other marbles are left unchanged.



A block removal is a defined series of moves that effectively remove a given set of marbles from the board, while 
leaving the rest in their original position.



L-move

To the left is a diagram of the move.    The X is currently empty, but will contain a marble after the move is 
complete.    The red circles are the marbles that will be removed.

Example



L-move Example

Starting position



Final position



4-move

To the left is a diagram of the move.    The D stands for "Don't Care".    The X is currently empty, but will contain a 
marble after the move is complete.    The red circles are the marbles that will be removed.

Example



4-move Example

Starting position



Final position



4-3-move

To the left is a diagram of the 4-3-move. The D stands for "Don't Care".    The X is currently empty, but will contain 
a marble after the move is complete.    The red circles are the marbles that will be removed.

Example 1
Example     2  



4-3-move Example 1

Starting position





Final position



4-3-move Example 2

Starting position





Final position



Flat-10-move

To the left is a diagram of the flat-10-move. The D stands for "Don't Care".    The X is currently empty, but will 
contain a marble after the move is complete.    The red circles are the marbles that will be removed.



I-move

To the left is a diagram of the i-move.    The X is currently empty, but will contain a marble after the move is 
complete.    The red circles are the marbles that will be removed.

Example



I-move Example

Starting position



Final position



Pointed-10-move

To the left is a diagram of the pointed-10-move. The D stands for "Don't Care".    The X is currently empty, but will 
contain a marble after the move is complete.    The red circles are the marbles that will be removed.



7-Plus-1-move

To the left is a diagram of the 7-plus-1-move. The D stands for "Don't Care".    The X is currently empty, but will 
contain a marble after the move is complete.    The red circles are the marbles that will be removed.



Tally-move

To the left is a diagram of the tally-move. The D stands for "Don't Care".    The X is currently empty, but will contain
a marble after the move is complete.    The red circles are the marbles that will be removed.

Example



Tally-move Example

Starting position

Final position



2-removal

To the left is a diagram of this removal. The U's are an unlike pair.    The red circles are the marbles that will be 
removed.

Example

Starting position

Final position



L-removal

To the left is a diagram of this removal. The U's are an unlike pair.    The red circles are the marbles that will be 
removed.

Example



L-removal Example

Starting position



Final position



6-removal

 

 

Above are diagrams of this removal. The D stands for "Don't Care".    The U's are an unlike pair.    The red 
circles are the marbles that will be removed.

Example



6-removal Example

Starting position



Final position



9-removal

To the left is a diagram of this removal. The U's are an unlike trio.    The red circles are the marbles that will be 
removed.

Example



9-removal Example

Starting position





Final position



Double-2-removal

To the left is a diagram of this removal. The U's are an unlike trio.    The red circles are the marbles that will be 
removed.



Double-3-removal

To the left is a diagram of this removal. The U's are an unlike trio.    The red circles are the marbles that will be 
removed.



Double-Y-removal

To the left is a diagram of this removal. The U's are an unlike trio.    The red circles are the marbles that will be 
removed.



11-removal

To the left is a diagram of this removal. The U's are an unlike trio.    The red circles are the marbles that will be 
removed.



Shifted-6-removal

 

Above are diagrams of this removal. The D stands for "Don't Care".    The U's are an unlike pair.    The red 
circles are the marbles that will be removed.



Straight-6-removal

To the left is a diagram of this removal. The U's are an unlike pair.    The red circles are the marbles that will be 
removed.



Y-removal

 

Above are diagrams of this removal. The D stands for "Don't Care".    The U's are an unlike pair.    The red 
circles are the marbles that will be removed.



Chain-removal

To the left is a diagram of this removal. The U's are an unlike sextet.    The red circles are the marbles that will be 
removed.



2-5-removal

To the left is a diagram of this removal. The U's are an unlike pair.    The red circles are the marbles that will be 
removed.



3-removal

To the left is a diagram of this removal. The U's are an unlike pair.    The red circles are the marbles that will be 
removed.

The first move in the Classic Game Solution example is a 3-removal.



Anvil

To the left is a diagram of the anvil move.    The D stands for "Don't Care".    The X is currently empty, but will 
contain a marble after the move is complete.    The red circles are the marbles that will be removed.

Example 1
Example 2



Starting position



Final position



Starting position



Final position



"Don't Care" (represented by a D) means that it doesn't matter whether there is a marble in that position or not.    The
move can still be performed.    If there is a marble in that position, it may be involved in the move, but will be 
restored after the move is complete.



An unlike pair are two positions on the board that do not match.    One of the positions must contain a marble.    The 
positions cannot both be empty nor both contain marbles.    The marble in the unlike pair may be involved in the 
move, but will be restored after the move is complete.



An unlike trio are three positions on the board that do not match.    One or two of the positions must contain a 
marble.    All three positions cannot be empty, nor can all three contain marbles.    The marble (or marbles) in the 
unlike trio may be involved in the move, but will be restored after the move is complete.



An unlike sextet are six positions on the board that do not match.    At least one of the positions must contain a 
marble.    All six positions cannot be empty, nor can all six contain marbles.    The marble (or marbles) in the unlike 
sextet may be involved in the move, but will be restored after the move is complete.



Solution to the Classic Game

The following is the diagram for a solution for this game:

This solution consists of 6 pattern moves and 1 single move into the goal.

1. 3-removal (f4 to d4, e2 to e4, d4 to f4)
2. 6-removal (e6 to e4, g5 to e5, g3 to g5, f3 to f5, e4 to e6, g5 to e5)
3. 6-removal (d5 to f5, e7 to e5, c7 to e7, c6 to e6, f5 to d5, e7 to e5)
4. 3-removal (c4 to c6, e5 to c5, c6 to c4)
5. 6-removal (a5 to c5, a3 to a5, b3 to b5, c4 to c6, a5 to c5, c6 to c4)
6. L-removal (d3 to b3, c1 to c3, e1 to c1, c4 to c2, c1 to c3, b3 to d3)
7. Single move into Goal position (d2 to d4)



Solution to The Square

The following is the diagram for a solution for this game:

This solution consists of 6 pattern moves and 1 single move into the goal.

1. 6-removal (c1 to c3, a1 to c1, a2 to c2, d1 to b1, c3 to c1, b1 to d1)
2. 6-removal (e1 to c1, d3 to d1, f2 to d2, c1 to e1, f1 to d1, d1 to d3)
3. 6-removal (d4 to d2, f4 to d4, f3 to d3, c4 to e4, d2 to d4, e4 to c4)
4. 6-removal (d6 to d4, f6 to d6, f5 to d5, c6 to e6, d4 to d6, e6 to c6)
5. 6-removal (b6 to d6, c4 to c6, d6 to b6, a6 to c6, a5 to c5, c6 to c4)
6. 3-removal (a3 to a5, c4 to a4, a5 to a3)
7. Single move into Goal position (a3 to c3)



Game Designer
This is the window that is used for designing you own board.    For example, to design the 
following game, which is a modified version of “A Big Plus”:

the game designer screen would appear as follows:



Enter your name in the Designer box, and the name of your game in the Description box.    If 
you change the dimensions of the game matrix by entering different values in the Width or 
Height boxes, press the Apply button.    The Apply button will redraw the game matrix in the 
lower portion of the window using the new dimensions.

Press the OK button to accept the game design, or Cancel to abort the design.

Click on the cells in the game matrix with the left mouse button to change their state.    The 
states are as follows:

Small black circle - This is a position that is not occupied by a marble.
Red circle - This is a position that is occupied by a marble.
Blue circle - This is a position that is occupied by a marked marble.    (only one is allowed in a
game)



Any of the above states, when combined with cross-hairs means that the position is the goal.
This is the position that must contain the sole remaining marble (or marked marble) at the 
end of the game.



Registration Form
Super Marble Solitaire 1.3

Registering by check:    To register by check send this form and a check to:
Wrenware
P.O.    Box 24455
Lyn-Mayfield, OH    44124
To print this form, click on Print Topic in the File pull-down menu.    Alternately, you can print 
the ASCII text file REGISTER.TXT.    Payments must be in US dollars drawn on a US bank, or 
you can send international postal money orders in US dollars.

Credit Card Orders: You can order with MC, Visa, Amex, or Discover from Public (software) 
Library by calling 800-2424-PsL or 713-524-6394 or by FAX to 713-524-6398 or by CIS Email 
to 71355,470. You can also mail credit card orders to PsL at P.O.Box 35705, Houston, TX 
77235-5705.
Request PsL item #14392.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.    WRENWARE CANNOT BE 
REACHED AT THESE NUMBERS.
Any questions about the status of the shipment of the order, refunds, registration options, 
product details, technical support, volume discounts, dealer pricing, site licenses, non-credit 
card orders, etc., must be directed to Wrenware.

Order over the Internet:
You can also order by credit card from Public (software) Library over the Internet.    Visit the 
Wrenware homepage for details:    http://ourworld.compuserve.com/homepages/wrenware

CompuServe Registration:    To have the registration fee added to your CompuServe bill, 
type GO SWREG and follow the menus.    The registration ID is 8408.

3.5 inch disks are sent.    Only Windows 95 and Windows NT are supported.

Prices guaranteed through December, 1996.    When payment is received, you will be sent a 
registered copy of the latest version of Super Marble Solitaire.

Super Marble Solitaire: ___ copies at $19 each = __________
Add $2 shipping for orders outside US & Canada __________

Total payment = __________

Name: _______________________________________
Company: _______________________________________

Address (line 1): _______________________________________
Address (line 2): _______________________________________
City, State, Zip: _______________________________________

Country: _______________________________________
Day Phone: _______________________________________

Evening Phone: _______________________________________



Electronic Mail
address:

_______________________________________

Comments:



Copyright/License/Warranty

Copyright © 1995,1996 Wrenware™
All rights reserved.

License Agreement
You should carefully read the following terms and conditions before using this software.    
Unless you have a different license agreement signed by Wrenware, your use of this 
software indicates your acceptance of this license agreement and warranty.

Unregistered Version
Evaluation and Registration
This is not free software.    You are hereby licensed to use this software for evaluation 
purposes without charge for a period of 30 days.    If you use this software after the 30 day 
evaluation period, you are required to order the registered version.    Payments must be in 
US dollars drawn on a US bank, and should be sent to Wrenware at the address indicated on 
the order form. When payment is received you will be sent a registered copy of the latest 
version of Super Marble Solitaire.

Unregistered use of Super Marble Solitaire after the 30-day evaluation period is in violation 
of U.S. and international copyright laws.

Distribution
Provided that you verify that you are distributing the unregistered version (select 

About from the Super Marble Solitaire Help menu to check) you are hereby licensed to make 
as many copies of the unregistered version of this software and documentation as you wish; 
give exact copies of the original unregistered version to anyone; and distribute the 
unregistered version of the software and documentation in its unmodified form via electronic
means.

There is no charge for any of the above.

Disk Vendors, Shareware Distributors and BBS(s) may charge a nominal fee for 
distribution of Super Marble Solitaire. The recipient of Super Marble Solitaire must be 
informed, in advance, that the fee paid to acquire the software does not relieve the recipient
from registering the software, if the recipient continues to use Super Marble Solitaire.

Registered Version
One registered copy of Super Marble Solitaire may either be used by a single person who 
uses the software personally on one or more computers, or installed on a single workstation 
used non-simultaneously by multiple people, but not both.    You may access the registered 
version of Super Marble Solitaire through a network, provided that you have obtained 
individual licenses for the software covering all workstations that will access the software 
through the network.

LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 
 



THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING 
INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND.
FURTHERMORE, WRENWARE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE 
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE.    THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU.    IF THE 
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU, AND NOT WRENWARE OR
ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT IS MADE BY 
WRENWARE, ON THIS WRENWARE PRODUCT.    NO ORAL OR WRITTEN INFORMATION 
OR ADVICE GIVEN BY WRENWARE, ITS DEALERS, DISTRIBUTORS, AGENTS OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.    
YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

NEITHER WRENWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE 
CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY
DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO 
USE SUCH PRODUCT, EVEN IF WRENWARE HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.
 
Governing Law

This Limited Warranty shall be governed and construed in accordance with 
the laws of the State of Ohio.

ACKNOWLEDGMENT

BY USING SUPER MARBLE SOLITAIRE, YOU ACKNOWLEDGE THAT YOU HAVE READ 
THIS LIMITED WARRANTY, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS' 
TERMS AND CONDITIONS.    YOU ALSO AGREE THAT THE LIMITED WARRANTY IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND
SUPERSEDE ALL PROPOSALS OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY 
OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT 
MATTER OF THE LIMITED WARRANTY.



Support

Unlimited support for this product can be obtained by the following means:

U.S. Mail
Wrenware
P.O. BOX 24455
Lyn-Mayfield, OH    44124

Electronic Mail
CompuServe: 71461,770
Microsoft Network: Rennie_A_Sawade
Internet: 71461.770@CompuServe.com or Rennie_A_Sawade@msn.com

Wrenware Home Page
http://ourworld.compuserve.com/homepages/wrenware

All problem reports and suggestions are welcome.



Definition of Shareware
Shareware distribution gives users a chance to try software before buying it.    If you try a 
Shareware program and continue using it, you are required to register it.

Copyright laws apply to both Shareware and retail software, and the copyright holder retains
all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like retail authors, and the programs are of comparable 
quality. (In both cases, there are good programs and bad ones!) The main difference is in the
method of distribution. The author specifically grants the right to copy and distribute the 
software, either to all and sundry or to a specific group. For example, some authors require 
written permission before a commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's retail or Shareware. The Shareware system 
makes fitting your needs easier, because you can try before you buy. And because the 
overhead is lower, prices are lower also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.

ASP Ombudsman Policy
This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products. Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-
9427 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536




